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QuickBooks® Online Foundations

Important Information about the Structure of this Training

Our QuickBooks Online Training is intended as the foundation for using QuickBooks®
as a bookkeeping, business management and cash flow building tool. The material
provides a critical basis for establishing bookkeeping best practices and ensuring

accurate financial information.

Please ask questions throughout the presentation.

In addition to what you will learn today this manual is a

post-training reference guide.

We are happy you are here and look forward

to helping you master QuickBooks!

© 2021Intuit Inc. QuickBooks Online Foundations
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QuickBooks® Online Foundations

The most important reason to advance our knowledge of QuickBooks® and basic
bookkeeping principles, whether you are a business owner or employee, is to improve
business performance.

While we identify specific learning objectives at the beginning of each section,

3 Overall Objectives include:

1. Introduction to basic features in QuickBooks and how they apply to best practice

bookkeeping principles.

2. How to effectively and efficiently use QuickBooks to manage daily bookkeeping tasks

and develop an understanding of how the data is entered, processed and reviewed.

3. How to customize QuickBooks to meet the specific needs of a business.

Why we teach Cash Flow with QuickBooks®

Business owners typically identify Cash Flow as their number one area of concern.
QuickBooks Accounting Software, when utilized correctly, allows users to run Cash Flow
projections and develop a Cash Flow management strategy to prevent shortfalls. This
training will help participants develop a strong knowledge base of how to use QuickBooks

reports to manage a business and build cash flow.

The foundation of business success is in the daily use of accuratetirealfinancial data.

What we measure, we manage; what we manage, we improve.

© 2021Intuit Inc. QuickBooks Online Foundations
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QuickBooks® Online Foundations

It is important to focus on the areas of our business that contribute most to profitability.
QuickBooks helps us easily identify areas of focus if we know where to look.

¢CKS ynkuHn Nz S 2NJ 6KS Wt NBd2 t NAYOALX SQ

In most cases, 20% of our customers generate 80% of our net profit. At the same time, 20%
of the goods or services we sell contribute 80% of our revenue, etc. You get the idea.

The most important value good bookkeeping brings to a business is an understanding of
where to focus.

By generating daily reports that uncover the best customers, jobs, services, or products,
you will soon see how you can refocus internal efforts on doing highly valuable work.

Accurate reatime data with one click access to reports, is an enormous benefit of using
vdza O1 . 221 &gl diGdS WNA IK
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Section 1 Objectives

Upon completion of Section 1, each participant will be familiar with:

A How to choose the right subscription.
A How to use additional features.

A How to import company data.

A How to setup a company file.

A How to view and use the Dashboard.

A How to navigate using QuickBooks Online Plus.

The purpose of Section 1 is to become familiar with different subscription options as

if you were a business owner deciding which subscription is right for your business.

Video links are available throughout this manual. Qse + Left Clickor direct

access.

Important: As part of your Intuit Education student subscription, you will receive a

free 1-year trial of QuickBooks Online Plus.

Each section of this training provides information on how to navigate and correctly use
various key functions within QuickBooks Online. In addition, you can choose to implement
the Case Study Activities. If you choose to utilize the Case Study Activities, simply follow the
step-by-step directions at the end of each section to create your TAD Gaming Services, LLC

using your free QuickBooks Online subscription.

© 2021Intuit Inc. QuickBooks Online Foundations
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Chrome Browser

Chrome is the recommended browser used to access QuickBooks Online. There are a few

things you need to know going forward.

Cookies and Cache

If you receive an error message when trying to access your company file:
Click thethree dotsin the upper right section of the Chrome browser.
ClickMore Tools.

ClickClear browsing data

MNew tab JT

Mew window Ctrl+N

MNew incognite window  Ctrl+Shift+N

History 4
PRIVACY L\) Downloads Ctrl+)
Bookmarks L4
Zaom - 100% = : :
Print... Ctrl+P
fin ® Money out Cast...
Find... , Ctrl+F
Save page as. Ctrl+5 Maore tools L4
Create shortcut... Edit Cut Copy Paste
Clear browsing data...  Ctrl+5hift=Del Settings
Extensions Help 4
Task manager Shift+Esc
Exit
Developer toals Ctrl+Shift+I

© 2021Intuit Inc. QuickBooks Online Foundations
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Select theTime range Cookies and other site dataandCached images and files.

ClickClear data.

Clear browsing data

Basic Advanced

Timerange  All time - '

Browsing history
1,025 items

Download history
None

Cookies and other site data
From 189 sites

Cached images and files
319 MB

0 Passwords and other sign-in data
None

— Autofill form data

Cancel Clear data

© 2021Intuit Inc. QuickBooks Online Foundations
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Bookmarks

Createbookmarksto save favorite pages. Click tB¢aron the right top of the browser bar

to create bookmarks. Choose a name and select a folder, then click done.

Incognito

Incognitoa 2 R S

-)p * O

X
Edit bookmark l
MName QBC and Chrome Tips & Tricks - Part 1 - it
Folder Bookmarks bar -

To get your bookmarks on all your devices, turn
on sync.

Turn on sync...

G NEFSNNBR (igh privacy fedtide that dis@bles tN2 ¢ & A Y

browsing history of Chrome.

© 2021Intuit Inc.
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Mew tab Cirl+T
Mew window , Ctrl+M

Mew incognito window  Cirl+Shift=MN

Histony b
Downloads Ctrl+]
Bookmarks ¥

16 QuickBooks Online Foundations



INTUIT

Features Education

Multiple Windows

Web-based applications utilize the functionality of web browsers. Imagine working in
several different windows in your QuickBooks® Online company file. Log in to your company
data file. In this example we will use Google Chrome.

Right click th&uickBooks Tab> Duplicate.You now have multiple windows open for your
data file and can perform multiple tasks. This is a great way to enter and review historical
transactions during the cleanup process.

€ QuickBooks ¥ -+
Mew tab to the right

< c a

TLG FF Apps_Websi

Reload Ctrl+R.

Duplicate
Pin \

Mute site

Close Ctrl+W

Another way to access multiple windows is as follows:

After logging into QuickBooks® Online go to the URL/address baopypdCtrl + Che
$S0aAGSQa I RRNSD & a Rasté (Kt ¥ \Ehis 2ddisg intb the/wdhdow.i | 6 ®
The tabs are as follows: first tabDashboard second tak; Search and

third tab ¢ Bank Deposit.

@' CuickBooks X @ Search X | @ Bank Deposit b |

« > C & c23.gbo.intuit.com/app/homepage

Note: In Chrome you can create an additional user specifically for QuickBooks® Online. You
can then save all your favorite tabs/pages and have them available when you log in to your
company data file.

© 2021 Intuit Inc. 17 QuickBooks Online Foundations
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QuickBooks Online Mobile App

TheQuickBooks Online Mobile Aglows instant access to your QBO data from
yourmobiledevice. More and more business owners are on the go and need easy and fast
visibility to their accounting data. You can create multiple types of transactions and attach
supporting documents or photos from your mobile app. Download the QuickBooks® Mobile
App to your Android phone, iPhone, or tablet. Once you complete the installation, log in to

your company file.

Compare Mobile App Features
https://quickbooks.intuit.com/learrsupport/enus/mobile-and-apps/comparemobile-app-
features/00/185540

How to Use the QuickBooks Mobile App Tutorial
Https://www.youtube.com/watch?v=yAUig4OdA

How to Attach Receipts Using Your Mobile Phone
https://www.youtube.com/watch?v=AuihXbjgmFg

Log in to your company data file from a computer. Clickbarchcon and select the
transaction you just created from your mobile app to add or change information as needed.
Verify the receipt photo/document is now available in the attachments list.

© 2021Intuit Inc. QuickBooks Online Foundations
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Subscriptions

Choose the Right Subscription

To determine the right QuickBooks® Online subscription for your business, open a new
browser window and enter this URL:
https://quickbooks.intuit.com/pricing

@ CQuickBooks Login - Sign into Q. X @ CuickBooks Online Pricing & Fre X

« > C 8 quickbooks.intuit.com/pricing/
q P g

1 year free Plus

subscription provided Freelancer ©

Small Business ©

MOST POPULAR by Intuit.
Simple Start Essentials Plus Advanced Self-Employed
s o o o150 s
$12%/mo $20/mo $35/m $75/me $75%mo

D O O o oo

Use the table to determine which subscription is best for your business.

Note: The pricing will change periodically.

Note: If you wish to try out QuickBooks® Online without using your own data or free

4dz0 AaONALIGA2Y (2 GKS a2FaGél NBx @&2dz Oy O
http://gbo.intuit.com/redir/testdrive that allows you to go in and test various features

in a prepopulated QuickBooks Online file.

© 2021Intuit Inc. QuickBooks Online Foundations
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Student Setup 'E[}Ic‘;ilm

Complete the following steps to successfully create your new Intuit QuickBooks Online

Company fileAccept Invitation-> Create Account> Next.

—— Create your account
INTUIT Education Already have an account? Signin
Email address (will be used as your user ID)

king_do@intuit.com

Your instructor has invited you to
create your own QuickBooks Confirm email
company

First name
Dear John,

Your instructor has invited you to create a QuickBooks Online Plus
company that you can use for the class for free. Click below to accept

the invitation.
Accept invitation Phone (Recommended)

Last name

Password

& Create Account

Welcome! We're glad you're here.

Here's what we'll do together right now.

© <

Tell us what you need help with We'll personalize QuickBooks and We’'ll bring in your transactions
make recommendations based on and organize your money
your needs

© 2021 Intuit Inc. 20 QuickBooks Online Foundations
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Complete the following steps to successfully create your new Intuit QuickBooks Online

Company fileAccept Invitation-> Create Account> Next.

—— Create your account
INTUIT Education Already have an account? Signin
Email address (will be used as your user ID)

king_do@intuit.com

Your instructor has invited you to
create your own QuickBooks Confirm email
company

First name
Dear John,

Your instructor has invited you to create a QuickBooks Online Plus
company that you can use for the class for free. Click below to accept

the invitation.
Accept invitation Phone (Recommended)

Last name

Password

& Create Account

Welcome! We're glad you're here.

Here's what we'll do together right now.

© <

Tell us what you need help with We'll personalize QuickBooks and We’'ll bring in your transactions
make recommendations based on and organize your money
your needs

© 2021Intuit Inc. QuickBooks Online Foundations
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For the Legal business name, (®eur First initial and Last name) TAD Gaming Services,
LLC. ExampldDoeTAD Gaming Services LLC. GClek.

R inturt
@qulckbooks SET UP QUICKBOOKS

What's your business name?

We'll use this to get you started in QuickBooks.

ol
\ E. Daigle TAD Gaming Services LLG]

| | use QuickBooks Desktop and want to bring in my data.

Important! industry type should bempty. This will reduce the number of account

categories that auto populate during this setup process. Gle.

@a’ﬁ’lckbooks SET UP QUICKBOOKS

What does your business do?
Start typing and select the option that fits best.

Leave this _
field blank ¥ =

What kind of business is thifartnership ClickNext.

Yy st
@qmckbooks sssssssssssssss

What kind of business is this?

Tell us sbout your business structure. We use this to help categorize your
transactions.

Sola proprictor

N2 ©,

© 2021Intuit Inc. QuickBooks Online Foundations
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It is important to selecBookkeeper/Accountanfor this step. This affects the terminology

used on the main windows in QuickBooks Online. Glik.

LY "
()] a'ﬂ'ICkbooks. SET UP QUICKBOOKS

What's your role at E. Daigle TAD Gaming
Services LLC?

We'll customize QuickBooks based on your answer.

& « | O

Bookkeeper or
Account tant

Owner or Partner Employee

Other

Who helps run this business? Seladew partners and ownersClick Next.

@gﬂ‘ckbooks. SET UP QUICKBOOKS

Who helps run this business?

Help us understand who's on your team. Select all that apply.

8 & =

Only the owner Employees Contractors

o

Afew partners and We plan to hire in the
owners future

© 2021 Intuit Inc. 23 QuickBooks Online Foundations
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Link your accounts and see everything in one place. We will not actually connect accounts

for this training. Cliclskip for now.

oo Guiickbooks

SET UP QUICKBOOKS

Link your accounts and see everything in

one place

QuickBook

will ically bring in

transactions and save hours of manual entry.

1 Securely link your bank or credit card
2 Select the accounts you'd like to bring in

3 See what your cashfiow looks like

casH FLow
Smonths v

$10,000

Current cash balance

?ﬂuhﬁ"

— Skip for now

What is everything you want to setu@heck off all the options to match the screen shot

below.

& giickbooks

SET UP QUICKBOOKS

What is everything you want to set up?

Your choices help build your setup guide. You can still use every part of QuickBooks.

o

Organize money in and out

4} =] Accept online payments

Enter and pay bills

< IR

Track recoipts and bills

Pay employees or contractors

&

Add sales

o

© 2021Intuit Inc.

Track time

Manage inventory

@ [+

Protect my business with insurance

QuickBooks Online Foundations
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Company Data

About TAD Gaming Services, LLC

Ryan, Emily and King are friends from college who have been working in the
Video Game industry for several years. Ryan is a beta tester, Emily a graphic
artist and King a programmer. The three have decided to start their own video

game company, with each of the 3 fulfilling a major role.

The niche they intend to fill is this. Video game creators will come to them
with ideas for a new game and the new company will program/code the video

game, create the graphics, then test the new game for customers.

To make their dream a reality, they understand that a solid financial
foundation and the use of the right tools is paramount to their success. There
is only one problem. While each partner understands their role, not one of

them has knowledge or experience regarding how to set up or run a company.

After extensive research, they find training that will walk them through how to
create and operate a profitable business using QuickBooks Online business

management software.

Today we will embark on the journey with them and learn how to successfully

set up a new business. Let the adventure begin!

© 2021 Intuit Inc. 25 QuickBooks Online Foundations
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As required by law, the partners must decide on and set up a business entity,
or business structure. Examples include corporations, partnerships and

limited liability companies. Their accountant recommended a:

Multiple Member LLC

Here is why. A partnership is the relationship existing between two or more persons who
join to carry on a trade or business. Each person contributes money, property, labor or skill,

and expects to share in the profits and losses of the business.

A partnership must file an annual information return to report the income, deductions,
gains, losses, etc., from its operations, but it does not pay income tax. Instead, it "passes
through" any profits or losses to its partners. Each partner includes his or her share of the

partnership's income or loss on his or her tax return.

Partners are not employees and should not be issued a Fe@in e partnership must
furnish copies of SchedulelK(Form 1065) to the partners by the date Form 1065 is
required to be filed, including extensions.

If you are a partnership or a partner (individual) in a partnership, use the information in the

charts below to help you determine some of the forms that you may be required to file.

https://www.irs.gov/businesses/smabusinesseselfemployed/llcfiling-as-a-corporation

or-partnership

https://www.irs.gov/businesses/smabusinesseselfemployed/partnerships

© 2021 Intuit Inc. 26 QuickBooks Online Foundations
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Distributive Payments

LLCs transfer their profits to the members, who receive distributions equal to their
ownership shares. For example, a member who owns atloingt ownership interest would
receive onethird of the profits. Profits can only be distributed when the LLC actually makes
money, so if there is no profit, there is no distribution. The LLC reports distribution income
using Partners' Share of Income, Deductions, Credits Iefeedule Kl), which is given to

each member. Members then report this income on their U.S. Individual Income Tax Return
(Form 1040 with Supplemental Income and LoSgledule Fattached.

Guaranteed Payments

Members of an LLC may need an ongoing income, as-phafitng does not happen weekly

or monthly. In these situations, members can receive what are called guaranteed payments,
which differ from a salary in that they do not subject the LLC to regular income and FICA
taxes. Instead, a guaranteed payment is adaguctible expense by the LLC that reduces

the business's net profit and is reported on U.S. Return of Partnership In€éame (065.

For the member, guaranteed payments are treated as income subject to estimated income
taxes and selémployment taxes. Guaranteed payments are made whether the LLC is
turning a profit or not.

The LLC's operating agreement should contain information about guaranteed payments, as
it's common practice for managing members to receive them. Note that a member may
receive both a salary, if he has a job within the LLC, and guaranteed payments for his role as

an owner. These payments are treated differently when it comes to taxes.

https://www.legalzoom.com/articles/thebasicsof-llc-guaranteedpayments

© 2021Intuit Inc. QuickBooks Online Foundations
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Importing Data

e

Informational Purposes Only. We will not actually import from Desktop for

this training.

Because business owners are transitioning from the desktop version to the online version of
vdzA O1 . 22142 LG Aa Fy AYLI Nidhroygh howts seibpaNBE § 2

new company when converting from the Desktop version of QuickBooks.

To import data from Enterprise or QB Desktop:

Click theGearicon. @Hlp Q 3 &

Under the Tools options, clickL YLI2Z NI 5Saj{d2L) 5F G o¢

You have the option to impoBank Data, Customers, Vendors, Accounts Categories,
Products and Services or Invoicesing a.csvor Excefile. Click the option and follow the

step-by-step instructions.

Import Data

Bring your existing data into QuickBooks

@ 6 6 0 0 ¢

Bank Data Customers Vendors Chart of Accounts Products and Services Invoices

Need to import QuickBooks Desktop data? Find out how ,

Need to bring in sales receipts, invoices, and expenses? Try this app ,

© 2021 Intuit Inc. 28 QuickBooks Online Foundations
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Choose to import &B Desktop, Maar Enterprisedata file. Watch the video entitled
Gl 2¢ 2 YAINIGS &2dz2NJ RI G ¢

Here's how to securely copy your desktop data online

Watch the short video on the right or follow the steps below to learn how.

i

o Using QuickBooks Enterprise? Please see Importing from Enterprise for instructions.

Print Instructions “

Follow this 3step process to import from
QuickBooks Desktop.

You can download a free trial of QuickBooks®
Desktop if necessary.

Step 1:

Open and update QuickBooks® Desktop

switch toSingleUser Mode-> File-> EXxit.

© 2021Intuit Inc. 29

Windows Mac p

Open QuickBooks Desktop

Don't have QuickBooks Desktop?
Download & free trial now.

1. Open QuickBooks Desktop

2. Choose Help » Update QuickBooks.
3. Click Update Now.

4_Click Get Updates.

5. If you're not in single-user mede, choose
File > Switch to Single-User Mode.

&. Choose File > Exit.
7. Restart QuickBooks Desktop.
8. If you have payroll, run it now.

If your company file is on a hosted server,
save a copy of it(.gbw file) on your computer now.

QuickBooks Online Foundations
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Importing Data

=y
@

Step 2: Export your company data

Export your company data as shown at right.

1.In QuickBooks Desktop, choose

Then, clickd 2 KI (i Qa Y 2 (ioview LJ2 NIj  Compeny > Export CompanyFile

to QuickBooks Online.

all transactions that will not migrate. 2. Follow the onscreen steps.

Most of your data will move over.

What's not imported? “

Step 3: D °®
Clicki wS I R afdga 8 E § OK (i dzii 2 NA

Sign back in online
to learn more about the import process
and avoid Costly mistakes. 1. Review your company settings and verify the data.

Read how “

2. Learn how to use QuickBooks Online.

Watch wtorials h

Note: This link will provide additional information:

https://community.intuit.com/articles/1145238mport-limitations-quickbooksdesktopto-

quickbooksonline/

© 2021 Intuit Inc. 30 QuickBooks Online Foundations
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Left Navigation Bar

The links on the left side act as your menu bar and will take
you to frequently used areas in QuickBooks® Online.

wrrhuid

P quickbooks

Post bank and credit card transactions in the Banking

Dashboard Center.

Use the + New icon to manually input data for Customers,
Vendors, Employees and other.

o _ _ : ,
i View expense history and vendor information.

Expenses

Access sales, customer and product from the Sales center.

Invoicing

Cash Flow Manage Employees and Contractors.

Payroll View and customize reports.

Reports

Review and maintain sales and payroll taxes.

Taxes

Mileage Track your mileage.

sl Maintain your chart of accounts categories.

My Accountant . .
Reconcile bank and credit card accounts.

Apps

Explore additional applications that work with
QuickBooks® Online.

© 2021Intuit Inc. QuickBooks Online Foundations
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+ New

The+Newicon in the Left Navigation Bar provides access to data input windows. This is

where you go to create Invoices, Receive payments, enter Expenses, Checks, Bills and more

Click the(+ New)icon to create manual transactions.

CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice Expenss Payrall # Bank deposit
Check Single time activity Transfer
Estimate Bill Weekly timeshest Journal entry
Credit memo Pay bills Statement
Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit
Delayed charge Print checks
Show less

Tip:! t gl @a SYGSNIRFGFE FNRBY aG2L) G2 o02G02Y3% |

information.

Additional icons includelelp, Search, Notificationand Settings Geaand Sign out Click
the Help icon to address questions for specific area@ui¢kBooks®Click theBellicon to

view recent notifications.

@Hp Q 3 B O

© 2021Intuit Inc. QuickBooks Online Foundations
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Search

TheSearch(magnifying glassgon at the top of theDashboardwill allow you to easily

search recent and historical transactions.
Click theSearchicon. (@) Hee QU [T 5%

Enter a transaction number, date, amount, etc.

for a simple search.

Q -

SEARCH TIPS Search for customers, vendors, transactions, or reports.

Search by name, address, amount (3340.00), date (MM/DD/YYYY) and mare.

RECENT Expense | Transfer | 01/25/2025 | $2,500.00
TRANSACTIONS
Expense | Transfer | 02/25/2025 | $2,500.00

Expense | Transfer | 03/25/2025 | $2,500.00

ClickAdvanced Searcto filter specific transaction types and more.

Armount

Sea [’Ch All Transactions ¥
Amount (Line or Total)

Refsrenceno. ¥ Contsins hd 5678 i
Display Name

‘ Add Filter Lest Modified Date

Line Description
Memo

Reference no.

© 2021 Intuit Inc. 33 QuickBooks Online Foundations
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Navigation Education

Gear

Click theGearicon at thetop right of yourDashboardo access company default settings,

lists, and tools.

YOUR COMPANY LISTS TOOLS PROFILE
Account and settings All lists Order checks (3 Feedback
Manage users Products and services Import data Refer a friend
Custom form styles Recurring transactions Import desktop data Privacy
Chart of accounts Attachments Export data Switch company
QuickBocks labs Reconcile

Budgeting

Audit log
SmartLook

Case center

You're viewing QuickBooks in Accountant view. Learn more Switch to Business view

© 2021Intuit Inc. QuickBooks Online Foundations





































































































































































































































































































































































































































































































































































































































































